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This handout contains screen shots of confidential and proprietary information for view 
only. It shall not be copied or shared for anything other than its intended purpose as a 
training device for the County of San Diego, Mental Health management Information 
System. 
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CONFIDENTIALITY 
 

HIPAA regulations mandate that all client information be treated confidentially. 
 

Access to CCBH is based on your position and your job classification. You will have the access 
you need to complete your job duties. This can include access to clients in your Unit/SubUnit or 
may include full client look up. Remember – with more access comes greater responsibility 
regarding confidentiality! 

 
You are not to share passwords with other staff. The Summary of Policy you signed before 
receiving your access to CCBH included your agreement to this directive. You are still 
responsible if someone with whom you have shared your password violates confidentiality! 

 
The MIS unit investigates any suspicions regarding sharing of passwords. Consequences are 
up to, and may include termination. 

 
Do not open any active client charts unless instructed to do so, or if it is required to complete 
your job duties. “Surfing” clients is a blatant breach of confidentiality. 

 
Remember you are personally and legally responsible for maintaining confidentiality. Take it 
seriously. 

 
Do not leave your computer unlocked with client data on the screen for others to access or view 
while you are away from your desk. Lock your CCBH session before leaving your computer. 

 
When printing, make sure you are printing to a confidential printer, and pick up your paperwork 
quickly. Leaving printed Protected Health Information (PHI) out is also a confidentiality violation. 

 
 
 

Play it safe – keep in mind how you would want your own PHI handled! 
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CCBH SOFTWARE BASICS 
 

• CCBH IS ACCESSED THROUGH CITRIX (Cerner): 
Go to https://cosdca.cernerworks.com 

 
• “TAB TO TRAVEL”: Get in the habit of using your “Tab” key. Using the “Tab” 

assures that you are directed to all required fields and that the information you 
input is actually captured by the system. 

• FILTERS/RADIO BUTTONS: Check these first and make sure they are on “all” 
when searching the database. 

• MAGNIFYING GLASS/ELLIPSES “BUTTONS”: When you see these at the end 
of a field, it means there is a “Search Screen” that you can pull up to find 
information for that field. You do not have to use them, but they are there if you 
need them. 

• REQUIRED FIELDS are in red or blue: They must be filled-in to save and final 
approve information. 

• OPTIONAL FIELDS are in white: Information may be added, but is not required 
to final approve the Assessment. Keep in mind – just because you have 
completed all the fields required to final approve the form, does not mean 
you have completed a thorough clinical assessment. Documentation 
standards have not changed. 

• CLOSED FIELDS are in gray: Nothing can be added in these fields. 

• CASE SENSITIVE: 

o Passwords – if you receive an error message for “Invalid Password”, check to 
make sure you are using the appropriate upper and lower case letters when 
typing. After a third attempt with an invalid password, the system will lock 
your session and will require contacting the Optum Support Desk 
(1-800-834-3792) to unlock it. 

o Table Searches – when searching within a table, be aware that descriptions 
or IDs are case sensitive. If you do not use the correct upper or upper and 
lower case entry, the search will not take you to the desired table value. 

• MULTIPLE WAYS TO ACCESS INFORMATION: In CCBH, it is easy to access 
the same information in multiple ways. We have included screenshots and 
directions in this document to guide you through the system. 

• LOCKING YOUR SESSION: For security purposes, you must lock your session 
any time you step away from your computer. This packet explains the various 
ways to lock your session. 

https://cosdca.cernerworks.com/
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• WHEN YOU GO BACK TO YOUR PROGRAM: You are learning how to enter 
assessments in the “SDC Train CCBH” environment during this training, which 
is for practice purposes only. It is important to enter all of your assessment 
information in the “SDC Live CCBH” environment when you return to your 
program. 

 
• For password resets/menu issues: Call the Optum Support Desk. You may also 

call if you need your “SDC Live CCBH” environment password or menu set up. 
Their contact information is: 

 

 
 

Reminder: 

Optum Support Desk 
1-800-834-3792 

 

Menu access is set according to job title/functions. The menus you have at your 
program may look different than menus shown in the screen shots in this packet. 
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CCBH SPEAK 
 
 

Assessment In CCBH, anything that is not a Client Plan or a Progress Note is 
considered an “Assessment.” So, in CCBH Speak, forms such as the 
Discharge Summary, Outcome Forms, and Demographic Form are 
considered “Assessments” as well as the actual clinical assessment 
forms. 

Assignment Opening/Closing a client to a specific program (Unit/SubUnit/s) and to 
a specific server. 

Clinician’s 
Homepage 

A “page” that provides the Clinical servers at each open assignment to 
view client/s and client information for the identified caseload in one 
screen. This includes client look up, caseload listing, appointments, 
task/s to do, notifications, and other client information present in the 
EHR. 

Collateral 
Server 

Co-Staff providing a service (i.e. co-facilitator). Used when more than 
one staff is providing a service to the same client, on the same date 
and at the same time as server. 

Demographic A client is entered into the EHR by the completion and final approval of 
the demographic form. A client may not be opened to 
assignment/program unless the demographic form is entered, 
completed, and final approved. 

Final Approve Locks the completed assessment. Prevents editing/deletion of 
assessments. 

SAI – Single 
Accountable 
Individual 

Primary server identified based on primary unit program set up. This 
staff will be listed as the primary contact for the client in the system of 
care for purposes of coordination of care. 

Scheduler A program within the EHR that allows for scheduling of client service 
events and ongoing appointment/s. This information will populate to 
the Clinician’s Homepage once entered into the EHR through the 
Scheduler menu. 

Service Code Procedure Code. The code data entered into the EHR for the purpose 
of claiming a service activity. 

Server Staff providing a service activity. 

Unit The Physical Location of a program, or legal entity. 

Sub-Unit The specialized set of services offered within a Unit (i.e. population, 
funding sources, etc.). 
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PASSWORD CHANGES 
Citrix (Cerner) Password 
The first Citrix (Cerner) password you ever receive is considered a temporary password. For 
security reasons, you will be prompted to change your password on your first log in. To do so 
after the initial login, click “Change Password” when first logging in to Citrix (Cerner). 

 

 
 
 
 

Next, follow the prompts to change your password. 
 
 
 
 
 

 
CCBH Password 
You are prompted by the system to change your CCBH password every 90 days. However, if 
you feel that someone has learned your password, for security reasons you should change it 
immediately. There are two ways to do this: 

 
Clinician’s Homepage 

From the Clinician’s Homepage, go to 
the “File tab”. Select the “Security” 
menu, and then select “Change 
Password”. Follow the prompts to 
change your password. 

 
 
 

External View 
 
From the External View, go to the “Access” 
tab and select the “Change Password” 
option. Follow the prompts to change your 
password. 
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LOCK CCBH SESSION 
 
For security reasons, the expectation is that you will lock your CCBH session any time you step 
away from your computer. There are two ways to do this. 

 
 

Clinician’s Homepage 
 

From the Clinician’s Homepage, go to the “File” tab and select “Security” from the drop down menu, 
then select the “Lock” button. At the prompt, select “Yes”. 

 

 

 

 

 

 

 

External View 
 

From the External View, go to the “Access” tab and then select “Lock Session”. 
 

 
 

You will be prompted to enter your password to unlock the session. 
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EXITING APPLICATION 
 

EXITING CCBH:  To make sure you do not accidentally create a “ghost session” and lock 
yourself out of accessing CCBH, you must exit in the following manner: 
 
 

Clinician’s Homepage 
 
 
 

o Go to the “File” tab in the top left-hand corner of your screen. 
o Select “Exit Application”. 

 

 
 
 

External View 
 

o From the external view, go to the “File” tab. 
o Select “Exit”. 
o Repeat this step for any open external view window. 

 

 
 
 

You risk being locked out of CCBH if you do not exit in the manner described 
above! 
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CLINICIAN’S HOMEPAGE TERMINOLOGY 
Identifying Terms Used on the Clinician’s Homepage 

Clinician’s Homepage: 
The Clinician’s Homepage is a real-time tool that provides up-to-the-minute client status at a 
glance. 

 
File tab: 
The “File” tab can be used to exit the application, set preferences, access the external view, or 
see recently opened views. 
 

 
 
 

Tabs: 
 
The “Tabs” listed below are displayed at the top of the Clinician’s Homepage. 
 

• There are four tabs: File, Home, Client, and View 

. 
 

Note: The “Client” tab will only be available if a client has been selected. 
 

 
Buttons: 

 
• The “Buttons” are individual selections that can be clicked on to perform various 

functions. 
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Ribbon: 

 
• The “Ribbon” is an object that is comprised of various buttons. 

 

 
 

 
Staff Panel: 
The Staff Panel automatically launches when the Clinician’s Homepage is opened. 
 
You will see your name as well as your job title listed. If you believe that the job title is 
incorrect, you must complete a new ARF form and submit it to the MH MIS Unit for 
correction. 
 

 
 
 

Caseload: 
The Staff Panel defaults to show your caseload. These are the clients who have been assigned 
to you. You can always return to your caseload by selecting the “Caseload” pane at the bottom 
of the screen: 
 

 
 



View Only 

View Only 08/2023 
12 

 

 

 
Identifying Client Type: You can find the client designation under the 

“Type” heading on the “Caseload” pane of the 
staff panel. There are three client types that 
may appear on your caseload: 

 
 

• SAI: this signifies that you are the Single 
Accountable Individual for the client listed. 

 

• Caseload: this indicates that, in addition 
to your program, the client is being seen at 
another program. You are not the SAI for 
this client type – the other program staff 
would be the SAI. 

 
 

• Pre-Intake: this indicates that the client is 
temporarily on your caseload as a pre- 
intake client. Pre-intake is intended for the 
purpose of allowing brief access by a 
clinician to the Client Chart for the process 
of screening before the client is assigned 
to a Unit/SubUnit. 

 
NOTES  
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Scheduled Services: 

 

 
Any clients displayed in this pane are scheduled for service events that calendar day. You can 
always return to this pane by selecting the Scheduled Services pane tab at the bottom of the 
window. 

 
Client Panel: 

 
• The “Client Panel” displays information about the client that you selected. The “Client 

Panel” consists of “Client Panes”. You may access the information contained in those 
panes by clicking on each pane. 

 
 

 
NOTES  
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CLIENT SEARCH 
 

Searching for a Client Who Is In Your Caseload: 
 

• On the Clinician’s Homepage “Home” tab, under “Caseload”, double click on the name of 
the client. 

• This action opens up the “Client Panel” where you can find information about your client. 
 

 
Searching for a Client Who Is Not In Your Caseload: 

 
o From the “Home” tab, select the “Client Search” button. 

 

 
 

o The “Client Lookup” window will open 
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There are several different ways to search for a client from this window: 

 
• By “Sort Name”: Enter the client’s sort name in the LAST NAME, FIRST NAME format, 

then select the “Search” button. (The “Sort Name” is the client’s name as formatted 
when first entered into the CCBH system): 

 

 
• If the Sort Name you’ve entered is in the system, it will be displayed in the “Client Search 

Results” area, as in this screen shot which exemplifies a search done for fictional client 
sort name, “PIE, APPLE”: 

 

 
• If the Sort Name you entered is not in the system, you will receive the following stop 

message: 
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• This does not mean that the client is not in CCBH. Rather, you may not have entered 
the sort name exactly as it was formatted when the client’s information was first entered 
into the CCBH system. For this reason, you should search by other criteria such as: 

 

Note: Before beginning another type of search, select the “Clear” button to reset the 
search criteria.  

• In client search, enter LAST NAME, FIRST NAME, date of birth (check spelling and in 
ALL CAPS). 

o If client is found with that name, double check SSN. 
• Search by SSN. 
• Search by Alias. 

o If match found, open the Demographic form on client and double check DOB, 
address, SSN. 

o Check 3rd Party information to see if client has the same Medi-Cal (BIC, CIN) 
number. 

• If it is unclear which is the first name or the last name, enter the other position of names 
in Alias – e.g., Bubble Gum entered into CCI as GUM, BUBBLE may be entered into 
Alias as BUBBLE, GUM. 

 

Note: When searching use all capital letters, these fields are case sensitive. 

• You can now search by one or more of the other criteria fields (Last, First, DOB, Alias 
Last, First, Sex, Case Number). Select the “Search” button. 

 
 
 
 
 
 
 
 

Note: If you search by data that is common in the system (such as conducting a 
search only by a common first name) you will receive the following warning screen. 
This allows you the option to either continue with or cancel the search. 
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Additional Client Search Feature 
 

• The “Thru” field, in conjunction with the “DOB” field allows you to search for clients within 
a particular date range. For example, if the DOB is approximately 3/10/1964 and you 
enter 3/08/1964 in the “DOB” field and 3/12/1964 in the “Thru” field, all clients in the 
system who have that dates of birth in that date range will be displayed in the “Client 
Search Results” window. 

 
Note: If the exact DOB is known ~ enter it in the ‘DOB’ and ‘Thru’ fields to find clients born 

only on that date. 
 

 
NOTES  
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RESTORE SYSTEM DEFAULTS 
 

If the layout becomes distorted, or the panes have disappeared, select “Restore Panel Layout” 
(under the “Layout and Filters” button on the “Home” tab). This will restore the layout to what it 
was when you first logged in. 
 

 
 

Select “Restore Panel Filters” (under the “Layout and Filters” button on the “Home” tab) to bring 
all the Filters back to their default settings, if desired. 

 

 
 

NOTES  
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CLIENT FACE SHEET 

 
The Client Face Sheet will allow users to view any entered information from the client’s 
most recent final approved Safety Alert, Demographic Form, and Diagnosis Form. The 
Client Face Sheet displays the Primary Unit, SubUnit and SAI for the client. If the client 
information has not been entered on one of these forms, the corresponding information 
fields on the Face Sheet will be blank. 

• After accessing a client, the Client Face Sheet can be viewed by clicking the “Face 
Sheet” pane in the client panel. 

 

 
• The Client’s Face Sheet cannot be edited from this view. To print click on the drop 

down arrow  at the top right, and click “Print Face Sheet”. 
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VIEWING ASSESSMENTS 
 

• Select a client and open the “Client Panel”. 
• Next, click the “Assessments” pane. 
• A list of assessments will display. The assessments that are final approved will have a 

check under the Final approved status (F/A). 
• Double click the assessment. The selected assessment will open in show mode. 

 

 
NOTES  
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FILTER SETTINGS 
 

Modifying filter settings to display historical assessments 
 

Each user may personalize the way filters display information in his or her Clinician’s 
Homepage. Any time you do not see the desired information, the first step is to check the filters 
to assure the correct parameters are selected for your search. 

 
1. On the “Client Panel”, click on the “Assessments” pane. The “Assessments” pane will 

open an expanded window. 
2. Click the drop down arrow  on the “Assessments” bar that displays on the right. 
3. A new window will display. Click on the check mark  or on the word “Filters”. 
4. The “Filters” window will display. There are three areas where you can make changes: 

Lookback Date: This date pre-populates back 48 months from the date you open the 
filter. If a desired assessment is before the date listed, and is not displaying on the 
“Assessments” tab; you can adjust the date manually. 

5. From the drop down menu, you may choose A: “Include Final Approved and non-Final 
Approved Assessments”, F: “Include Final Approved Assessments only” or N-“Include 
non-Final Approved Assessments only”. 

6. You may also place a checkmark by the “Include the latest Assessment of each type 
only” choice given. 
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Filters in Clinician’s Homepage: 

 
Several panes located within the Client Panel contain “Filters”. Below are some examples: 

 
Assignments Pane Filters: updates the Assignments Pane to display Opened and Closed 
Assignments. 

 
 

Services Pane Filter(s): updates the display of the Services Pane. The date field filters for 
services on or after the date entered. Check boxes further filter that data, for particular service 
types or services by specified staff, for example. 
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VIEWING CLIENT ASSIGNMENTS 
Clinician’s Homepage 

 
Client “Assignments” refer to where the client has received, or is currently receiving, services. In 
the “Clinician’s Homepage” you can view the Opening/Closing dates when a client was 
assigned to a specific program (Unit/SubUnit/s) and to a specific server. 

 
A. In the “Client Panel” click on the “Assignments” pane. 
B. It displays all the assignments attached to the client. 

 

 
NOTES  
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PRINTING CLIENT MEDICATIONS 
 

A list of the client’s medications can be printed from the Medications Pane. 
 

• With the Client panel open, select the “Medications” pane at the bottom of the screen. 
 

 
• On the right top portion of the Client panel, select the down arrow. 

 

 
 

• A drop down menu will 
launch. Select the “Print 
Medications” option. 

 
 

Note: This menu will also 
appear when right clicking in the 
white space within the client 
panel. 

 
 
 

• Adjust the printing 
options to what is needed. Users 
can choose to print only a 
certain medication type, to 
include pre-approved or 
discontinued medications, and/or 
to include all medications or only 
current medications. 

 
 

• When finished adjusting 
the filters, select “Print.” 
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PRINT TO SCREEN 

Note: Before printing a hard copy, always print to screen first to verify whether printing is 
truly necessary. 

 
• Click the “Print” button. 

 

 
 

• Click on the down arrow to the right of the “Printer” field, click “Print Preview”, and click 
the “Print” button. 
 

 
 
 

It will take a few moments to process the command. Wait until the 
following message disappears. 

 
 
 

A copy displays on the screen. Pay attention to the total number of pages before deciding to 
print a physical copy. 
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Icons 
 

You will find icons across the top of the print screen which will allow navigation through the 
copy. 

 

 
 

 Prints a physical copy. 

 Emails a copy. DO NOT use this feature, as it is a breach in confidentiality. 

 Displays the default size of the copy. 

 Shrinks the copy down to 25% of the default size. 

 Zooms in by 50% each time the icon is clicked. 

 Zooms out by 25% each time the icon is clicked. 

 Navigates directly to the first page. 

 Navigates back one page. 

 Navigates forward one page. 

 Navigates directly to the last page. 
 

 Displays keyboard commands for navigating through the copy. 

 Displays the details of the software product. 

• Closes out of "Print to Screen” and returns to the original view. 
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DISPLAY AUDIT EVENTS 
 

To see when an assessment was added, edited, final approved, viewed, or printed, utilize 
Display Audit Events. Display Audit Events will display who touched the assessment, when, and 
what action was completed. 

1. Right click on the assessment details you wish to view. Select “Display Audit 
Events.” 

 

 
2. Each column in the window that appears can be sorted by clicking on the column 

header. The window will display a line for each separate action a staff takes (add, 
edit, sign, final approve, display, and print). 
 

 
 
 

3. Select “Close Panel” to return 
to the Assessments Pane.                                                                                          
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STAFF MAINTENANCE LOOKUP 
How to Lookup a Staff for Contact Information 

 
 

• From the CLINICIAN’S HOMEPAGE, click the Systems Button, click “Menu”, click 
“System Tools”, and click “Staff Maintenance”. 

 

 
 
 

• From the EXTERNAL VIEW, locate “Staff Maintenance” under “System Tools”. 
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“Staff Maintenance” Menu: 
 

When the “Staff Maintenance” Menu launches, your staff ID and name will be highlighted in blue 
as a default. Your current contact information on file will be listed in the “Main (1)” tab below. 

 

 
To begin your search: 

 
• Press the “Find” button at the bottom of the window. 
• The “Search: Sort Name” box will launch. 

 
NOTE: You may search by “ID” or “Sort Name” by clicking under the desired column before 
pressing “Find”. A red dotted box will display under the field you 
are searching. 
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Search Window:  
 
 

• Type in the desired name 
of the staff you wish to find. 

 
 
 

NOTE: The format must be last name, comma, then SPACE, and first name. For example, 
“CLINICAL, STAFF” would be the proper format. 

 

 

• The contact information of the staff for which you have entered will display under “Main”. 
 

• The “Internal Phone” number as well as the “Email Address” will be listed when it is 
available. 

 
NOTES  
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SCHEDULER 
 

Scheduler is a comprehensive support system that helps clinicians to manage their clients’ 
treatment plans. With the Scheduling System, you have the flexibility to define schedules for 
clients and clinicians. You can view a schedule over one day, two days, a week, or a month. 

 
The portion contained in this packet is a limited version of how you can use Scheduler. Several 
Administrative staff have been trained in this part of the software in depth. 

 
There are multiple ways to access Scheduler in CCBH. 

 
From the External View: 

 
• Click on the “Scheduler” menu. 
• A drop down menu will display, select “Scheduler Maintenance- Multi Day”. 

 
From the Clinician’s Homepage 

 
• From the “Systems Button”, select “Menu”, then “Scheduler”, then “Scheduler 

Maintenance - Multi Day. 
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The Multi-Day screen will display. 

• “Entity Type” will default to Staff. 
 

 
To view a schedule 

 
1. Enter the CCBH ID number in the “Entity” field and press the tab key on the 

keyboard. NOTE: If you wish to schedule for a client instead of staff, change the 
“Entity Type” to “Client”, and enter a client case number in the “Entity” field 

2. Leave the “Location” field on “All” 
 
 

 
NOTES  
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TRAINING TIP SHEET 

1. WHEN YOU GO BACK TO YOUR PROGRAM: 
□  You are learning how to enter assessments in the “SDC Train CCBH” 

environment during this training, which is for practice purposes only. It is 
important to enter all of your assessment information in the “SDC Live CCBH” 
environment when you return to your program. 

 
2. SUPPORT DESK – IMPORTANT!: 

□ Please do not try to solve issues by “working around” the system. You are to 
enter data as required and you must call the Support Desk for any questions. 

 
□ The Support Desk contact information is: 

 
Optum Support Desk Contact Information 

800-834-3792 
sdhelpdesk@optum.com 

 
3. FOR ONLINE USER MANUALS AND FORMS: (including forms and form-fill 

versions of assessments for “emergency” situations) go to the Optum website 
below and follow these instructions: 

https://www.optumsandiego.com 

□ Click "Register" to get an on-line form for your personal login. 
□ Confirm your email address. 
□ When you have access, click “Login”. 
□ Login with your User Name and Password. 
□ Go to "Secure Documents". 
□ Select CCBH (formerly Anasazi) Secure Documents 
□ Click "Forms" or "Manuals". 

4. TO REGISTER FOR ADDITIONAL TRAINING: 

www.regpacks.com/Optum 
5. HIPAA REGULATIONS FOR TRAINING: There is actual client data (names, etc.) in the 

training environment. HIPAA regulations mandate this information be treated 
confidentially. 

6. NON-USE OF CCBH ACCOUNT: Inactive accounts pose a security risk by allowing an 
opportunity for unauthorized access. Therefore, in order to safeguard protected health 
information, inactive accounts will be closely monitored. Users who have not used CCBH 
in 90 days will have their account deactivated. 

mailto:sdhelpdesk@optum.com
https://www.optumsandiego.com/
http://www.regpacks.com/optum
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Support Desk Contact Information 

sdhelpdesk@optum.com 
1-800-834-3792 

 
Monday through Friday (E-mail) 

Hours  Services 
6:00 am to 6:00 pm All services except password resets or any service involving PHI 

Monday through Friday (Telephone) 
Hours  Services 

4:30 am to 6:00 am Resetting passwords (24 hour programs) and reporting system outages* 
6:00 am to 6:00 pm All services 
6:00 pm to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

Weekends (Telephone) 
Hours  Services 

4:30 am to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

* By definition, a system outage affects multiple users. Examples include when: 
-The system does not respond and appears to be frozen 
-No data can be entered or viewed 

 
Support Desk Suggestions 

 
• Please consult with your program manager and your resource packet prior to 

contacting the Support Desk. 
 

• When calling for a password reset on weekdays between 4:30-6a or 6-11p, or 
calling weekends between 4:30a-11p, you must leave a message. Include your 
name, CCBH staff ID, phone number and the reason for your call. 

 
• You may be given a ticket/tracking number if you call between 6:00a and 6:00p 

Monday through Friday. Remember to keep this number for future reference. 
 

Additional Contacts 
 

Questions Where To Go 
Clinical Documentation Questions Documentation Manual/Your Program Manager 
Duplicate Clients and 
Name/DOB/Gender/SSN Changes 

Complete Form BHS-025 and 
Call Medical Records: 619-692-5700 x 3 

Financial Questions (UMDAP/Insurance) Billing Unit: 619-338-2612 Fax- 858-467-9682 
Online User Manuals and Forms www.optumsandiego.com 
Service Codes CCBH (Anasazi) User Manual/QM Unit 

 

mailto:sdhelpdesk@optum.com
http://www.optumsandiego.com/
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